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About the Author

Esther Friedberg Karp, MBA

President, EFK CompuBooks Inc.

Esther Friedberg Karp is an internationally-renowned trainer, writer, business consultant and speaker
who was named one of the Top 10 QuickBooks ProAdvisors in the world, with the title Top
International ProAdvisor.

Based in Toronto, Canada, Esther has the unique distinction of holding ProAdvisor certifications in
the United States, Canada and the United Kingdom. She has authored materials and delivered
educational and certification courses for Intuit in all those countries, as well as Australia where she
conducted live QuickBooks Online training. She has spoken at Scaling New Heights, QuickBooks
Connect and other conferences, as well as those of various accounting and professional
organizations and written countless articles for Intuit Global.

Esther counts among her clients’ companies from around the world, as well as accounting
professionals who seek her out on behalf of their own clients for her expertise in various countries’
editions of QuickBooks Desktop and Online, and for her talent in customizing QuickBooks usage for
different industries.

Esther holds a BSc from the University of Toronto in Actuarial Science and Mathematics, and an MBA
in Marketing and Finance from York University’s Schulich School of Business.

She can be reached at esther@e-compubooks.com or 416-410-0750.

Business Services

QuickBooks 2018 Student Guide 5


mailto:esther@e-compubooks.com

Lesson 2 — Setup Lesson Objectives

Lesson Objectives

Discuss decisions that must be made before using QuickBooks
Create a new QuickBooks company using the EasyStep Interview
Set QuickBooks preferences in the interview

Record the opening balance for a checking account

Enter customers, jobs, vendors, accounts and items for a QuickBooks company
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Create a QuickBooks Company

A QuickBooks Desktop company contains all the financial records for a single business. Before you
can use QuickBooks, you need to tell QuickBooks about your business, so it can set up your
company file properly.

1. Express Start will set up a new company file based on some standard industry settings. (Any fine-
tuning of the company file can be done later.)

2. Detailed Start opens the EasyStep Interview and will give you more control over fine-tuning your
company file as you set it up.

3. Your other options are to create a file by copying list data from an existing file or by converting

data from another accounting system.

In the Detailed Start option, you will set up the following using the EasyStep Interview:

Company information

Chart of Accounts based on your industry
Company organization

Sales information

Sales tax information

Estimates

Sales receipts

Preferences

Business start date

Create an account and enter the opening balance

Review the Chart of Accounts

Complete company file setup
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Start the EasyStep Interview

@
2! Step-by-Step: Begin to Add a New Company

1. Start QuickBooks.

2. Click the Create a new company file button from the No Company Open window or choose
New Company from the File menu.

3. Click the Detailed Start button to start the EasyStep Interview.

Let’s get your business set up quickly!

Answer some basic questions and we'll do
the rest. You can always make changes later. Express Start
(Recommended for new users)

Control the setup and fjfle-tune the Create a new company file based Convert data from Quicken or other
company file. on an existing one. accounting software.
Detailed Start Create Other Options =

4. QuickBooks displays the EasyStep Interview window.

NOTES
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Enter Company Information

]

2! Step-by-Step: Create a New QuickBooks Company File

Enter Company Information

1. Atthe first Welcome window for the EasyStep Interview, the Enter your company information
window appears.

2. Enter the business name in the Company name field and press Tab.

When you press Tab, QuickBooks automatically enters that name into the Legal name field.
QuickBooks uses the company name on all reports.

3. Press Tab again and enter the EIN or SSN in the Tax ID field.

4. Complete the remaining contact information for the company. QuickBooks will pull this
information onto sales forms and tax reports when you begin working in the file.
Your screen should resemble the following.

¥ Getanswers
Enter your company information
EasyStep'Interview
QuickBooks uses this information on your tax forms and forms you use to communicate with your
customers and vendars.
{—l—
Interview Progress * Companyname | ;cihart Design
Legal name Lockhart Design
The . Unless you use 3 DBA name, this will probably
TaxID 99-1234567
Your Federal Employer Identifcation Number (EIN) or Social Security Number, Used anly on tax
Street address 123 Anyroad
City T State o, . | Zip
Country Us. -
Phone 888-555-1234 Fax
Use the format you would like displayed on your forms, e.g. (555) 555-1212
E-mail address me@mybusiness.com
Web site |www.mybusiness.com|
Need help setting up? T * required field What if | have more than one business?
inTur
Find ALocal e -}
< QuickBooks Expert e
(fees may apply) —_— Leave... < Back Next> |
5. Click Next.
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Choose Your Company Industry

@
2! Step-by-Step: Choose your Company Industry to Create a

Chart of Accounts

1. Choose your industry from the list to help QuickBooks compile a suggested Chart of Accounts
for your business.

Step Interview

¥ Getanswers

Select your industry

EasyStep’Interview
Tell us your industry and we’ll customize QuickBooks to work best for you.

| | You will be able to review our recommendations and change them in this interview. And, you can always
Interview Progress change each of these settings later. Explain

Don't see your industry? Choose an industry thatis similar to yours. Examples

Select an industry from the list

INDUSTRY
Medical, Dental, or Health Service
Non-Profit
Professional Consulting
Property Management or Home Association
Real Estate Brokerage or Developer

Rental

Repair and Maintenance '

Restaurant, Caterer, or Bar

Retail Shop or Online Commerce

How does QuickBooks use my industry selection?

Need help setting up? L S
infuit

Find ALacal =

< CluickBooks Expert e

(fees may apply) e Leave... < Back

2. Click Next.

NOTES
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Select How Your Company is Organized

@
2! Step-by-Step: Select your Company Organization

1. Choose the company’s entity type (for example, Sole Proprietorship, S Corporation, LLC, etc.).
This will allow QuickBooks to create suggested tax mapping for your Chart of Accounts.

2. Click Next.

3. Enter the beginning month of the business's fiscal year — commonly January. (Remember: if a
company'’s year-end is December, you would enter January as the first month of the year.) Then
click Next.

4. Inthe Set up your administrator password window click Next. You can set the password later. If
you don't set up a complex password (seven characters, including at least one upper case
character and one number) now, you'll be prompted to do so the next time you open this
company.

5. Click Next to save the company file.

6. Name your company file (it ends in .QBW) and choose the location on your computer where you
wish to save it.

7. Click Save.

NOTES
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Customize QuickBooks for your Business

After you've saved the company data file, the customization section of the EasyStep Interview
appears. Itis the place where you indicate:

® Whatyou sell
® How and when your customers pay you

® How you pay your bills

Based on your answers, QuickBooks sets preferences for the company file. The preferences enable
certain features of the QuickBooks program.

yStep Interview

¥ Getanswers

Customizing QuickBooks for your business
EasyStep’Interview
Mext, we'll customize QuickBooks by turning on features that best meet your business needs. To do

this, we'll ask you questions about
| |
Interview Progress Your industry and what you sell
How and when your customers pay you

How you pay your bills

==

The features that appear in your

1 = i P T custom Home page will be based on
) e 8 & your answers.
| ¥ 9, -
I = = =
] g 8

Not sure what you'll need for your business? Answer the interview questions based on your current
Need help setting up? needs. You can easily enable additional features later

infurt
FindALocal )
7 QuickBooks Expert k- =l

(fees may apply) = Leave... < Back

NOTES
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Indicate What You Sell

You need to indicate what your business sells. In general, businesses either sell products, services or
both. Margaret Lockhart provides consulting services as well as selling products such as fabrics.

@
2! Step-by-Step: Indicate What You Sell

1. Click Next to move to the What do you sell? window.

2. Choose the appropriate option for the business (services only, products only, or both services
and products).

yStep Interview

i Getanswers
What do you sell?
EasyStep’Interview
1 Services only

Such as consulting, rentals, gym memberships, hair styling services, event services,
I— construction and labor.
Interview Progress

7 Products only

Such as lamps, ferilizer, books, hardware, tickets, insurance policies. Manufacturers and
distributors should also select this option

(= Both services and products
Such as a bicycle repair shop that sells bikes, a carpetinstallation company that sells carpet.

Need help setting up? —
infurt

Find A Local
7 QuickBooks Expert

(fees may apply) Leave... < Back | Hext = |

3. Click Next.

NOTES
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Enter Sales Information

Retail companies need to indicate how they want to enter sales. QuickBooks uses this information to
set recommendations for a retail-type business. (Note: you may have encountered these windows in
the EasyStep Interview if you chose a different type of business other than retail.)

@
2! Step-by-Step: Indicate How you Enter Sales (for Retail Companies)

1. Inthe How will you enter your sales in QuickBooks? window, choose the option that best fits the
business’s needs.

yStep Interview

¥ Getanswers
How will you enter your sales in QuickBooks?
EasyStep’Interview _
® Record each sale individually:
_ You can also print sales receipts to give customers.
Interview Progress 7 Record only a summary of your daily or weekly sales
If you use a cash registerto ring up individual sales, you can enter the sales totals (for the day,
week, etc.) into QuickBooks.
' Use QuickBooks Point of Sale
You can send the details of each individual sale into QuickBooks—uwith just one click.
Need help setting up? —
mruir
FindALocal
< QuickBooks Expert __
(fees may apply) - Leave... < Back | Next= |
2. Click Next.

NOTES
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Enter Sales Tax Information
[ ]
Enter Sales Tax Information

This part of the EasyStep Interview asks whether you charge sales tax. You should turn the sales tax
setting off only if you never charge sales tax. Sometimes it is even beneficial to turn this feature on for
tracking wholesale/retail sales, depending on the tax reporting regulations in your state.

v
0

Step-by-Step: Set up QuickBooks to Track Sales Tax
1.

Click Yes in the Do you charge sales tax? window.

EasyStep Interview

i Getanswers
Do you charge sales tax?
EasyStep’Interview

Meed help setting up? —
infuit

Find ALocal -,
< QuickBooks Expert '*"‘_’“
(fees may apply) ke Leave... < Back
2. Click Next.
NOTES
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Lesson 2 — Setup Create Estimates

Create Estimates

If you provide any type of estimate or bid — even a verbal quote — there are many reasons to use
estimates in QuickBooks. With QuickBooks estimates you can do the following:

® Prepare professional-looking itemized estimates, bids, quotes or proposals for your customers

® Create an invoice from the estimate with just one click; QuickBooks then creates and populates
an invoice for this customer using details from the estimate you used for that customer

® Create reports that compare your estimated costs and revenue against your actual costs and
revenue

Compare your actual costs against what you estimated

@® Track which estimates are still active and easily update each estimate as you continue to
negotiate with your customers
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]
0

1.

Create Estimates

Step-by-Step: Create Estimates for Your Business

the business.

On the Do you want to create estimates in QuickBooks? window, choose the option that best fits

Step Interview

EasyStep’Interview

Do you want to create estimates in QuickBooks?

i Getanswers
Some businesses referto estimates as quotes, bids, or proposals.
Interview Progress

' No

Why should | use QuickBooks to create my estimates?

Heed help setting up?

infurd
FindALocal -
< QuickBooks Expert e
(fees may apply) Leave... < Back Next =
2. Click Next.
NOTES
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Lesson 2 — Setup Create Sales Orders

Create Sales Orders

Sales orders allow you to record an order for a sale before the sale is actually made. These forms are
common in businesses that order products to fill orders or that pull orders from inventory before
invoicing. (Think of these forms as “incoming purchase orders” from customers.) These forms enable
you to create partial invoices for an order if you have inventory items on backorder.

@
o Step-by-Step: Create Sales Orders for Your Business

1. On the Tracking customer orders in QuickBooks window, choose the option that best fits the
business.

EasyStep Interview

¥ Getanswers

Tracking customer orders in QuickBooks
EasyStep’Interview

Use a sales order to track customer orders that you plan to fill at a later date, such as backorders or
special orders.

Interview Progress Sales orders can be used to track any of your unfulfilled orders or manage your inventory.

Some examples:

A bike shop receives an order for a custom-built bike. A sales order is used to track the order and is
then converted to an invoice when the customer picks up the finished bike.

Awholesaler receives an order for 1,000 couches. The sales order adjusts inventory levels to show
these couches are spoken for.

Do you want to track sales orders before you invoice your customers?

You can change a sales order to an invoice with one click.

Meed help setting up? —
infurt

FindALocal -
< QuickBooks Expert "“‘L_:
(fees may apply) i Leave... < Back | HNext > |
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Lesson 2 — Setup Choose Remaining Preferences

Choose Remaining Preferences

The next series of windows asks Yes or No questions that either enable or disable different
QuickBooks features based on your company’s needs. Simply click Yes or No, then click Next to
move forward in the Interview.

OPTIONS DESCRIPTION

BILLING STATEMENTS Post statement charges independently of invoices and sales receipts

PROGRESS INVOICING Create single estimates to be invoices in phases

BILL TRACKING Use the accounts payable module to track bills and bill payments
INVENTORY Use the inventory module to track inventory quantities and values
TRACK TIME Use timecards to track employee and subcontractor time

EMPLOYEES Use payroll module to manage employee information and payroll
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Lesson 2 — Setup Choose Remaining Preferences

You can always change preference settings after the EasyStep Interview has been completed. To
change the preferences later, access the Edit menu, choose Preferences, then select the preference
type in the left panel.

Accounting A My Preferences Company Preferences @
B sis

m Pressing Enter moves between fields Bring back all one time messages Cancel
Calendar
) Automatically open drop-down lists Turn off pop-up messages for products Help
SA checiing when typing and senvices
qﬂ Desktop View «| Beep when recording a transaction +| Show ToolTips for clipped text Default

o; I
Finance Charge Automatically place decimal point Warn when deleting a transaction or

@ General “ Unused list item .
+ Warn when editing a transaction Also See:

:i Integrated Applications

Reminders
g ftems & Inventery AUTOMATICALLY RECALL INFORMATION
% Jobs & Estimates ¥ Automnatically remember account or transaction information
% Multiple Currencies 1 Automatically recall last transaction for this name
E Payments (! Pre-fill accounts for vendor based on past entries

Ef, Payroll & Employees

ey DEFAULT DATE TO USE FOR HEW TRAN SACTIONS
L) Reminders

7 Use today's date as default ® Use the last entered date as default
Jdll  Reports & Graphs
m Sales & Customers KEEF CUSTOM ITEM INFORMATION WHEN CHANGING ITEM IN TRANSACTIONS
9l sales Tax ® Ask O Always O Never

ﬁ Search
[a Send Forms

% Service Connection
Speling

NOTES
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Choose a Start Date

The start date is the date you give QuickBooks a financial snapshot of your company assets and
liabilities before you start entering live transactions. It is generally the last day of the previous fiscal
period.

@
o1 Step-by-Step: Choose a Start Date

1. On the Using accounts in QuickBooks window click Next.

2. Choose the option that best suits the business setup.

¥ Getanswers

Select a date to start tracking your finances

EasyStep’Interview
The date you select will be your start date in QuickBooks.

]
Interview Progress

/® Beqinning of this fiscal year; 01/01/2017

In order to complete this year's tax returns, you'll need to enter transactions
from the beqginning of this fiscal year to today.

1 Use today's date or the first day of the quarter or month.

You'll need to enter transactions from this date forward.

What date should | choose?

Need help setting up? -~
infurf

FindALocal
< QuickBooks Expert e
(fees may apply) . Leave... < Back | Next> |

3. Click Next.

NOTES
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Lesson 2 — Setup Review the Chart of Accounts

Review the Chart of Accounts

The Chart of Accounts is made up of five types of accounts common to all businesses — the income
and expense accounts used by the Profit and Loss Statement, and the asset, liability and equity
accounts used by the Balance Sheet. Each time you enter a transaction, QuickBooks will prompt you
to categorize it into one of these five accounts.

Because you chose an industry from the list earlier in the Interview, QuickBooks has already created
income and expense accounts for your company based on that choice. You can add, delete or
modify accounts long after you make this choice. QuickBooks is very flexible that way.

@
2! Step-by-Step: Review the Chart of Accounts

1. Inthe Review income and expense accounts window, scroll through the preset accounts to get
an idea of what is included. Modify the selections according to your business needs by adding or
removing checkmarks.

tep Interview

¥ Getanswers

Review income and expense accounts

EasyStep’Interview
Income and expense accounts categorize money your business earns from, or spends on, normal

business operations.
]
Interview Progress 4 for your industry are typically all you need
for income tax purposes. Explain

Income

Need help setting up?

FindALocal
- QuickBooks Expert
(fees may apply)

nfurt

Contifid
P

-

< |Sales Discounts Income
Senvice Sales Income

< |MerchantAccount Fees Cost of Goods Sold
Product Samples Expense Cost of Goods Sold
Purchase Discounts Cost of Goods Sold
Purchases - Resale ltems Cost of Goods Sold

< |Advertising and Promotion Expense

+ |Automaobile Expense Expense

v

Restore Recommendations

You can modify your chart of accounts anytime after completing this interview.

Leave...

< Back

HNext >

2. Click Next.
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Congratulations! You have completed the EasyStep Interview.

tep Interview

¥ Getanswers
EasyStep’ Interview
You've completed the EasyStep Interview.
|
Interview Progress
You now have a company file with customized settings for your business.
Mext we'll help you enter your critical business info using QuickBooks Setup.
Meed help setting up? —
nruTt
FindAlLocal =
< QickBooks Expert
{fees may apply) . < Back Go to Setup
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3. Click Go to Setup.

The QuickBooks Setup screen appears.

Get all the details into QuickBooks

Add the people you do business with
Why do this? Import or enter your contacts so you can bill your customers, pay

our vendors, and track your employees. See how it warks

Add the products and services you sell
Add More

You've added 2 non-inventory parts

have. Don't worry we won't connect to your bank. & See how it works

Add your bank accounts
Why do this? So you can track deposits, payments and how much money you

Start Working

Mo data to enter right now? No problem. You can always add it later.

After you have completed the EasyStep Interview, use the information in the Help options described
later in this document to help you make changes and adjustments to your company file.

NOTES
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Lesson 2 — Setup Enter Bank Accounts and Opening Balances

Enter Bank Accounts and Opening Balances

The balance sheet accounts in the QuickBooks Chart of Accounts start with an opening balance of
zero. Before you begin working in QuickBooks, you need to enter an opening balance for each
balance sheet account as of your start date.

@
9! Step-by-Step: Enter Bank Account Information

1. On the Add your bank accounts section of QuickBooks Desktop Setup screen, click Add.

2. Name each bank account in the Account name column. Be descriptive with businesses that have
multiple bank accounts to eliminate confusion.

3. Ifyou are using account numbers in QuickBooks (to identify the categories in the Chart of
Accounts), be sure to enter the corresponding number in the Account number column.
This is not where you enter the actual bank account number from the bank!

4. For Opening balance, enter the balance in the account as of the date you are beginning the file.

5. For Opening balance date, use the date you are using to begin the file. The opening balance
amount should reflect the balance in the Opening balance date column.

QuickBo esktop Setup

{a¥ Add your bank accounts = i

accounts options

You can add as many bank accounts as you'd like. The only required info is the account name. We won't actually connect to your bank, we'll just create a register so you
can track income and expenses.

Account name ‘Account number Opening balance Opening balance date
Chase Checking 1000 52,839.00 12/312017

Chase Savings 1001 100,202.00 12/31/2017
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Lesson 2 — Setup Enter Bank Accounts and Opening Balances

= IMPORTANT: The above action creates an increase to your checking account balance and an increase to
your opening balance equity account balance.

6. Click Continue.
7. Inthe Order Checks screen, select No Thanks (or Yes, remind me later) then click Continue.

8. If you selected Yes, remind me later, you will see a Create Alert screen regarding printing
checks.

9. Click Start Working.

10. Close the Quick Start Center and you're ready to work in QuickBooks.

NOTES
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Lesson 2 — Setup Complete Company File Setup

Complete Company File Setup

After you have created your company file using the EasyStep Interview, you can begin using
QuickBooks to run your business.

However, there are some additional tasks you might need to do to make sure the company file is
properly set up and the data is complete.

The upcoming screen captures were created using one of the QuickBooks sample companies that
comes installed with QuickBooks Desktop, rather than the new company that was created earlier in
this lesson.

QuiIckBOOKS IS BASED ON FOUR KEY LIST CONCEPTS
® Accounts

® ltems

® Customers & Jobs

® Vendors

NOTES
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Add Customers

The Customer Center is the dashboard that can launch sales forms (sales orders, estimates, invoices,
sales receipts, statement charges, receive payments and credit memos/refunds) and display
accounts receivable.

@
o Step-by-Step: Add a Customer

1. There are multiple ways to do almost anything in QuickBooks. To access the Customer Center
you have four options:

® Click Customers from the left-hand or top icon bar (depending on your View settings)
® Choose Customer Center from the Customers drop-down in the menu bar

® From the Home page, click the blue Customers tab in the Customers section

® Press CTRL+j

2. Click the New Customer & Job menu button, then choose New Customer.

3. Inthe Customer name field, enter the name of the customer as you'd like it to appear on your
Customers & Jobs list.

4. Press Tab past the Opening balance field to leave this field blank.

The Opening balance field tells you how much each customer owes you on your start date so
that when you enter the rest of your transactions from the day after your start date to today, all
balances since your start date will be accurate.

= IMPORTANT: [t is recommended to enter individual outstanding invoices one by one whenever possible,
rather than entering the outstanding balance owed in the Opening balance field.
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Lesson 2 — Setup Add Customers

5. Complete the customer contact information appropriately.

You can have and use more than one Ship To address per customer or job. Add them with the
Ship To drop-down or by clicking the + sign in the bottom right corner.

New Customer

GUSTOMER NAI.-'E“

OFEMING BALANCE a5 0F (12M15/2022 @@ | How do | determine the opening balance?
Address Info
COMPANY NAME
Payment Settings FULL NamE | Mr/Ms.L.| | First M.I. || Last
. JOB TITLE

Sales Tax Settings

Main Phone = Main Email -
Additional Info -

Work Phone = CC Email -
Job Info Mobile - Website -

Fax - Other 1 -

ADDRESS DETAILS

INVOICE/BILL TO SHIF TO -

(N
+

Copy >>

%

b

Default shipping address

|| Customer is inactive “ Cancel Help
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6. Click OK to add this customer. The Customer Center appears with the Customers & Jobs list
along the left side. (New names appear at the top of the list. Right-click on the list and choose
Re-sort List in order to return all the names on this list to alphabetical order.)

Customer Center Esther Friedberg Karp

A& Hew Customer &Job ¥ | New Transactions ¥ "
Edit Customer
Customers & Jobs RIS =Rr0ED her Friedberg Karp -
Active Customers = > SALANCE 0.00 How do | adjust the current balance?
R Agdress Info coursny NaweE | EFK CompuBooks Inc. kTS FOR THIS CUSTOMER
NAME i BALANCE ... } ATTA Payment Settings FULL NamE  Ms. Esther 1 Friedberg Karp sport
A e —
+» Esther Friedberg Karp 0.00 _ JosTime | President batance
Ab bie. K 0.00 l Sales Tax Seftings
+ Abercrambie, Kristy - Main Phone = | | (416) 410-0750 Main Email = || esther@e-compubaoks.com Fstimates
«Family Room 0.00 Additional Info —
] = WorkPhone CCEmail = er Snapshot
o+ Kitchen 0.00
+Remadel Bathroom 0.00 00 Infa Mobile L4 Website L4
+ Allard, Robert 14,510.00 Fax - Other 1 v
+Remodel 14,510.00
ADDRESS DETAILS
+ Babcock's Music Shop 0.00 —
INVOICE/BILL TO SHIP TO -
+Remodel 0.00 — '
N EFK CompuBooks Inc.
« Baker, Chris 0.00 91326 Toronto Ave. ¢ +
+Family Room 0.00 Northridge, CA91326 Copy >»
Esther Friedberg Karp
+Garage Repair 0.00
+ Balak, Mike 0.00
«Utility Shed 0.00
+ Barley, Renee 0.00
Repairs 0.00
*Rep Customer is inactive “ Cancel Help
+ Bauman, Mark 0.00
+Home Remodel 0.00
=

=  IMPORTANT: The Customers & Jobs list is the same list as the Customer/Job list. It is called Customers &
Jobs on the Customer Center and called Customer:Job on forms. It is sometimes also referred to as
simply the Customer list.

NOTES
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Add a Job

You do not need to add jobs to the Customers & Jobs list if your company never does more than
one job or project per customer. Jobs in QuickBooks are optional. If you often perform multiple jobs
for the same customer, you can use jobs in QuickBooks to track the activity for each job separately.

The Customer:Job hierarchy can be customized to meet many different needs and is commonly
used in construction. This feature enables you to use the Customer as a parent under which you
group multiple jobs. (Another common use of jobs is for attorneys who handle more than one matter
for each client.)

@
2! Step-by-Step: Add a Job for a Customer

1. Inthe Customers & Jobs list, right-click on the customer name you would like to add a job for
and choose Add Job.

2. Name the job in the Job name field.

3. Forthe Opening balance, refer to the information in Add a Customer in the previous chapter.

Customer Center: Abercrombie, Kristy

&] MNew Customer & Job * ,;% New Iransactions ¥
Customers & Jobs Jos NA}.‘EIPﬂﬁD « \‘ custouwER  Abercrombie, Kristy ~ oTE
Active Customers - > 0l B EALANCE asoF 12M15/2022 B How do | determine the opening balance?
2 03: Send Kristy
Address Info i i : 2 for den remodel
COMPANY NAME
2 03 Called Kristy to

NAME Payment Settings FuLL NamE  |Mrs Kristy M1 | Abercrombie
o Abercrombie, Kristy 0.00 A [P RTS FOR THIS CUSTOMER

«Family Room 0.00 ' CEATEIID Report

Main Phone =  415-555-6579 WMain Email =  kristy@samplename.com

»Kitchen 0.00 f— : Balance

+Remaodel Bathroom 0.00 WorkPnone  + CC Email - Estimates
« Allard, Robert 14,510.00 WMobile ) Website = rane Crmnebat

+Remodel 14,510.00 Fax - Other 1 =
+ Babcock's Music Shop 0.00

+Remodel 000 ADDRESS DETAILS 2

N SHIF TO -

« Baker, Chris 0.00 i

+Family Room 0.00 Kristy Abercrombie & + 7.632.28 A

- 5647 Cypress Hill Rd

»Garage Repair 0.00 Bayshore CA94326 Copy>> 767613
» Balak, Mike 0.00 452200

«ility Shed 0.00 71115
+ Barley, Renee 0.00 -711.15

+Repairs 0.00 31128
o Bauman, Mark 0.00 74375 v

Jobis inactive

+Home Remodel 0.00 “ Cancel o

+ Bolinski, Rafal 0.00
v
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4. Click OK.
5. The job will now appear under the Customer (also referred to as parent) in the Customer list.

6. Close the Customer Center by clicking the x in the top right corner of the Center (not the top
right corner of QuickBooks, which will close the program!) or by hitting the Esc key.

=  IMPORTANT: Notice there are more tabs with information you can add for Customer:Job setup. These
features include payment information, sales rep and job status. It is important to understand your
tracking and reporting goals to ensure these features are set up and utilized properly.

NOTES
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Add Vendors

In order to pay your bills with QuickBooks, you need to add your vendors (sometimes referred to as
suppliers). Nearly everyone you pay, other than employees, is a vendor. Your Vendor list supplies
the names available on purchase forms like purchase orders, vendor credits, sales tax payments,
payroll tax payments and bills.

@
2! Step-by-Step: Add a Vendor

1. Just like the Customer Center, there are multiple ways to access the Vendor Center in
QuickBooks.

® Click on Vendors from the left side or top icon bar (depending on your View settings)
® Choose Vendor Center from the Vendors drop-down in the menu bar
® From the Home page, click on the Vendors tab in the Vendors section

2. Click the New Vendor button then choose New Vendor.

3. Inthe Vendor name field, enter the name of the vendor as you'd like it to appear on your Vendor
list.

= IMPORTANT: In the Opening balance field, this is treated the same as the Customer Center entries. You
can enter a balance owed to the vendor as of the start date of the file, but it is a best practice to enter
individual open bills whenever possible.

4. Enter the remaining vendor information appropriately.
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5. Click OK to add this vendor.

The new vendor appears on the Vendor list. (New vendors automatically appear in their correct
alphabetical order in the Vendor list.)

Vendor Center: New Vendor

Al New Vendor.. v FE| Mew Iransactons ¥ (&) Print ¥ Excel ¥ Word ¥ (@ Bill Tracker
Vendors V d I f t @ 4
€naor Intformation * 10T
Active Vendors hd >
Company Name Mo note available
jel Full Name
REPORTS FOR THIS VENDOR
s Billed From
NAME BALANCE ... ! ATTACH QuickReport
Larson Flooring 0.00 — Open Balance
Lew Plumbing 1,330.00
Madrid, Winnie 0.00
Mason, Elizabeth 0.00 Order Checks
McClain Appliances 0.00
Mendoza Mechanical 000
Middlefield Drywall 1,200.00
Miller, Dan 0.00 Transactions Contacts To Do's Notes Sent Email
New Vend
m- swow  All Transactions w | FutERBY Al * | pate This Fiscal Year * | 0101/2022 - 12/31/2022
Pacific Paint Supplies 0.00
Patton Hardware Su..  4,479.20 e e e S SR
Perry Windows & Do... 6,705.00
QuickBooks MasterC... 0.00 There are no transactions of type "All Transactions™, filtered by "All", in date range "This Fiscal Year
Rand, Jenn 0.00 l
Reyes Properties 0.00
Sergeant Insurance 4,050.00
Sloan Roofing 1,047.00
" Manage Transactions v Run Reports A
State Board of Equali 95734 v

6. Close the Vendor Center by clicking the x in the top right corner of the Center (not the top right
corner of QuickBooks, which will close the program!) or by hitting the Esc key.

= IMPORTANT: Notice there are additional tabs in the Vendor setup window. Feel free to utilize these
features as they apply to your business. Pay special attention to the Tax Settings tab if you would like to
run 1099 reports from QuickBooks.

NOTES
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Set Up Additional General Ledger Accounts

During the EasyStep Interview, you added your bank accounts. Bank accounts are one specific type
of general ledger account.

There are two categories of general ledger accounts:

@® Balance sheet accounts, which include bank accounts and other asset accounts, liabilities and
equity accounts

® Profit and loss (also known as income statement) accounts, such as income and
expense accounts

Income and expense accounts track the sources of your income and the purpose of each expense.
When you record transactions, you usually assign the amount of the transaction to one or more
income or expense accounts.

General ledger accounts are the core of QuickBooks. Every posting transaction (which is a
transaction that affects the general ledger) is mapped from one account to another. For example,
when you purchase paper for your office printer you are taking money from the bank account and
recording it against an office supplies expense account. Your Chart of Accounts is home to all the
general ledger accounts (also referred to as categories) that appear on your financial reports.
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@
o  Step-by-Step: Add an Account

1. From the Lists menu, choose Chart of Accounts (or press CTRL+a).

2. Click the Account menu button (at the bottom left of the window) and choose New (or press
CTRL+n from the Chart Accounts window).

3. Inthe Add New Account window, choose the appropriate account type then click Continue.

4. If account numbers have been enabled in the Accounting Preferences (Edit > Preferences
~>Accounting > Company Preferences ->Use account numbers), you will be able to enter the
account number in the Number field.

5. Click in the Account Name field and name the account appropriately.

6. Ifit's a subaccount of another account of the same type, check the Subaccount of checkbox and
specify the parent account

7. Optionally, use the Description field to add a description.

8. From the Tax Line Mapping drop-down list, choose the appropriate mapping according to the
business structure (or leave blank if you are unsure) to help in preparing income taxes for the
company.

= Add New Account = 0O

[T AccountType  Income - Number 4001

AccountName  Consulting
Subaccount of -

OPTIONAL

Description

Note

Tag-Line Mapping [ESuERE Il AL ~ | Howdolchoose the right tax line?

| Save & Close | Save & Hew Cancel
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9. Click Save & Close.

NOTES
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Add Items

ltems are what we use on sales forms like estimates, sales orders, invoices and sales receipts. Items
show the products/services that are sold and each item is mapped to one or more accounts in
QuickBooks. Iltems can be mapped to one, two or three accounts in QuickBooks, depending on the
item setup.

® One-sided Items - These items are used only on either a sale or a purchase form, not both. For
example, if you sell consulting services, you may have an item named Consulting for use on your
invoices. This item will be mapped to an income account to view on your Profit & Loss report. If
this item were used on a purchase transaction, it would post a negative transaction to your
income account.

® Two-sided Items - These items are used on both a sale and a purchase form. The setup for these
items allows you to post to an income account when used on a sales form and post to an
expense account when used on a purchase form.

® Three-sided Items - Three-sided items are used for inventory. The setup of these items allows
you to purchase the item and receive it into your Inventory Asset account (part 1). When you sell
the inventory, the item posts to your Income account (part 2) and makes a Cost of Goods Sold
entry (part 3).

In this section, we will look at a one-sided item entry.
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@
9! Step-by-Step: Add a One-sided Item

1. From the Lists menu, choose Item List.

Loak for in Allfields » Reset Search within results
MANME DESCRIFTION TYFE ACCOUNT TOTAL QUANTITY .} ONSALE.. | PRICE ATTACH
+Roofing Roofing Senice 40100 - Constructio.. 0.00
+Tile &Cou... Install tile or counter Service 40100 - Constructio.. 0.00
» Cabinets Cabinets Inventory Part 40100 - Constructio.. 0 0 0.00
+Cabinet P.. Cabinet Pulls Inventory Part 40100 - Constructio.. 423 0 0.00
+Light Pine | Light pine kitchen cabinet wall unit Inventory Part 40100 - Constructio B 2 1,799.00
» Door Frame  standard interior door frame Inventory Part 40100 - Constructio bal 0 0.00
» Hardware Inventory Part 40100 - Constructio.. 0 0 0.00
«+Brass hin... standard interior brass hinge Inventory Part 40100 - Constructio.. 245 0 0.00
+Doorknob... Standard Doorknobs Inventory Part 40100 - Constructio.. 124 0 30.00
+LkDoork... Locking interior doorknobs Inventory Part 40100 - Constructio.. 122 0 38.00
> Wood Door Doars Inventory Part 40100 - Constructio 1 0 0.00
= Exterior Exterior wood door Inventory Part 40100 - Constructio.. 16 0 120.00
«|nterior Interior wood door Inventory Part 40100 - Constructio.. 47 0 T2.00
» Interior Door.. complete Interior door Inventory Assem... 40100 - Constructio.. 20 0 0.00
» Lumber Lumber Non-inventory P.. 40100 - Constructio.. 0.00
+Trim Trim lumber Non-inventory P... 40100 - Constructio.. 0.00
+Decking Decking lumber Mon-inventory P.. 40100 - Constructio 0.00
=Rough Rough lumber Mon-inventory P.. 40100 - Constructio.. 0.00
| ltem ¥ Acfivities ¥  Reports v | Excel ¥ | Aftach Include inactive

2. Click the Item menu button at the bottom left of window and choose New.
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3. Inthe New Item window, choose an item type from the Type drop-down list.

= IMPORTANT: When you select an item type, a description of how that item should be used will appear to
the right of the drop-down box.

Mew ltem
s [ ok
Senvice - Usefarservices you charge for or purchase, like
specialized labor, consulting hours, or professional Cancel
fees.
Hext
ltem Name/Mumber Subitem of
Notes

UNIT OF MEASURE Custom Fields

UM Set - Edit... Spelling

This service is used in assemblies or is performed by a subcontractor or partner

Description Rate 0.00
Tax Code Tax -
Account - Item is inactive

How can | set rates by customers or employees?

4. Assign an item name or number in the Item Name/Number field.

5. Inthe Description field, enter the information you would like to appear by default when this item
is used on a form. (This default information can be overwritten on any individual transaction.)

6. You can assign a standard per unit selling price in the Rate field.

7. Inthe Tax Code field, assign a standard taxable or non-taxable code.

= IMPORTANT: [tems marked non-taxable in the setup will not accrue sales tax on sales forms. See the
Sales Tax training section for additional information.

8. Inthe Account field, choose the appropriate income account to post to when this item is used on
sales forms.

9. Click OK to add the new item to the ltem List.

10. Close the Item List.
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Enter Historical Transactions

If your QuickBooks start date for a new business (starting to record transactions in QuickBooks from
the very inception of the business) is before today’s date, you need to enter past transactions so you
have complete financial records from the start date going forward. (Existing companies that have
been in business for some time before starting to use QuickBooks will require more steps.)

@
2! Step-by-Step: Enter Historical Transactions in this Order

1. All sales (sales receipts, invoices, credit memos or statement charges) issued on or after the start
date.

2. Customer payments received for outstanding invoices on or after the start date.
3. Bills and bill credits (also known as vendor credits) received on or after the start date.
4. Bills paid since the start date.

5. Deposits made to any of the accounts on or after the start date.

6. Any other checks written and credit card charges made (other than to pay bills), as well as bank
charges and pre-authorized payments on or after the start date.

NOTES
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Set Up QuickBooks — Review Questions

1.

During the EasyStep Interview, QuickBooks creates income and expense accounts based on
your company's

When setting up a company file in QuickBooks, what does the start date signify?
a. The date the business was created

b. The first date of the company’s fiscal year

c. The date the company purchased QuickBooks

d. The date from which you will be entering transactions in QuickBooks

When setting up a company file in QuickBooks at the beginning of a fiscal period, you would
normally select which of the following as the start date?

a. The first day of the current fiscal period
b. The last day of the previous fiscal period

True or false: Once you have set up the Chart of Accounts, you cannot add, delete or modify
accounts.

a. True
b. False
Before working in QuickBooks, you need to enter an for each

balance sheet account.

True or false: Choosing a company organization associates a tax form with your business in the
QuickBooks file.

a. True

b. False
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7. In QuickBooks, linking income and expense accounts with tax lines does which of the following?
a. Helps keep your company profitable
b. Helpsin preparing income taxes
c. Helps keep track of sales taxes you owe

d. Bothbandc
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Answers to Review Questions

1. During the EasyStep Interview QuickBooks creates income and expense accounts based on your
company's industry.

2. When setting up a company file in QuickBooks, what does the start date signify?
a. The date the business was created
b. The first date of the company’s fiscal year
c. The date the company purchased QuickBooks
d. v The date from which you will be entering transactions in QuickBooks

3. When setting up a company file in QuickBooks at the beginning of a fiscal period you would
normally select which of the following as the start date?

a. The first day of the current fiscal period
b. v The last day of the previous fiscal period

4. True or false: Once you have set up the Chart of Accounts you cannot add, delete or modify

accounts.
a. True
b. v False

5. Before working in QuickBooks you need to enter an opening balance for each balance sheet
account.

6. True or false: Choosing a company organization associates a tax form with your business in the
QuickBooks file.

a. v True

b. False
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7. In QuickBooks, linking income and expense accounts with tax lines does which of the following?
a. Helps keep your company profitable
b. v Helps in preparing income taxes
c. Helps keep track of sales taxes you owe

d. Bothbandc
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